
LAB PRT03: Integrating Microsoft® 
SharePoint® Products and 
Technologies with Microsoft® Office 
Professional Edition 2003 Applications 

Objectives 
 

Module 1: Using Microsoft Windows SharePoint Services with Microsoft 
Office Professional 2003 Applications.  Learn to configure and use Document 
Libraries, versioning (from both Microsoft Office and Internet Explorer), 
multiple file upload, sub folders, WebDAV support, Image Libraries, Lists 
(Datasheet view, Microsoft® Office Excel 2003 Integration, Attachments), and 
Events (including Microsoft Office Outlook 2003 Integration). Estimated time 
to complete this module: 60 minutes 

Module 2: Using Microsoft Office FrontPage 2003 to Customize Microsoft 
Windows SharePoint Services.  Learn to apply a Dynamic Web Template to a 
Windows SharePoint Services site, create a DataView for XML and List data, 
and create a connection between list and detail data.  Estimated time to 
complete this module: 60 minutes 

Estimated time to complete this lab: 120 minutes 
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 Module 1 

Exercise 1  
Exploring Windows SharePoint Services Features 

In this exercise, you will work with the key features of Windows SharePoint 
Services.  

Note: To perform the tasks in this lab, you may need to use the online Help 
available on the Windows SharePoint Services site.  Access the Help by 
clicking Help in the top navigation bar. Most of the information you need is 
listed under “How do I…” on the Help screen.  

 Create your Window SharePoint Services site 

1. Login as the “Jeff Teper” user (username “jeff”, password “P@ssw0rd”) 
2. Open Outlook (a link is available on the taskbar, or in the system tray if it is 

already running) 
3. Open Internet Explorer and go to the Portal Home Page (if it isn't already 

opened) 
4. Click “Sites” in the horizontal navigation bar 
5. Click “Create Site” under “Actions” in the left navigation zone  
6. Type “Research” in the Title field and URL name field.  
7. If not already auto-filled type “jeff@contoso.com” for the e-mail address 
8. Click “Create” at the bottom of the page 
9. Click “OK” at the bottom of the next two pages 

 Create a new Document Library called “Research”  

1. Click “Create” in the top navigation bar 
2. Choose “Document Library” 
3. Enter “Research” for the name and choose “yes” under Document Versions 
4. Click “Create” to add the library 

 Upload documents to the library  

1. Click “Upload Document” 
2. Click “Upload Multiple Files…” 
3. From the folder view on the left side of the page expand “Desktop”  “My 

Computer”  “Local Disk (C:)” 
4. Click “Sales Fileshare” and select all of the documents 
5. Click “Save and Close” to upload the documents.  Click “Yes” to confirm. 

 Version a document - check out the document, save the changes, and 
check in the document  

1. Hover over the “Case Study wjc” document, click the down arrow, and 
select “Check Out” on the drop down menu 
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2. Hover over the “Case Study wjc” document, click the down arrow, and 

select “Edit in Microsoft Office Word” 
3. Click OK when prompted 
4. Add <Contoso Confidential> to the top of the document and click the “save 

icon” to save it 
5. Exit Microsoft® Office Word 2003 

a. In the “Check In” dialog, select “Check in file” and click “OK” 
b. Type a version comment and click “OK” 

6. Repeat steps 1-5 another time to generate multiple versions 

 View the version history of document 

1. Hover over the “Case Study wjc” document, click the down arrow, and 
select “Edit in Microsoft Office Word”  

2. Click OK when prompted 
3. On the File Menu, select Version History  In a document Library 
4. Observe that you can view versions in the Office application 
5. Close the dialog 

 View the document workspace pane in an Office application  

1. On the right-hand side of Word, you will notice a document workspace task 
pane.  You can use this pane to add and edit tasks, links, documents etc 

2. Exit Word 

 Create a subfolder in document library  

1. Switch back to Internet Explorer and ensure that you are in the Research 
document library 

2. Click “New Folder” in the toolbar 
3. Type “Clinical Trial Results” in the Name field 
4. Click “Save and Close” 
5. Browse to the new “Clinical Trial Results” folder that you created 

 Upload files into subfolder  

1. Click “Upload Document” in the toolbar 
2. Choose “Upload Multiple Files…” 
3. From the folder view on the left side of the page expand “Desktop”  “My 

Documents” 
4. Click “Clinical Trial Results” and select all of the documents 
5. Click “Save and Close” to upload the documents.  Click “Yes” to confirm 

 Delete a file 

1. Click “Up” in the toolbar to browse back to the root of the document library 
2. Hover “Case Study rmn” in the document library.   Click the down arrow, 

and select “Delete” 
3. Click “OK” to confirm 
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 Create an announcement about new org chart and attach the chart   

1. Click “Home” in the horizontal navigation bar 
2. Click “Add new announcement” in the Announcements section 
3. Type “New Contoso Org Chart” in the Title field 
4. Type in any text you want for the announcement.  You can use the new 

“rich” text features such as bold, italic, colors, etc. 
5. Click “Attach file” in the toolbar 
6. Type “C:\Documents and Settings\jeff\My Documents\Contoso Org Chart 

new.vsd” in the Name field 
7. Click “OK” 
8. Click “Save and Close” to save the announcement. 
9. Click the announcement subject to view the announcement 
10. Click “Contoso Org Chart new.vsd”  to view the attachment 
11. Click “Open” to confirm 

 Add items to the Tasks list with the datasheet feature  

1. Click “Documents and Lists” in the top navigation bar 
2. Click “Tasks” from the Lists section 
3. Click “Edit in Datasheet” in the toolbar 
4. Add some tasks, update values, and enjoy using the Datasheet control 
5. Use “Fill down” to change priority of several tasks 

a. Select the Priority column.  Right-click and select “Fill  Fill Down” 
6. Bring up the “Totals” row and switch to average 

a. Enter some % Complete values 
b. Select “Totals” from the toolbar 
c. Hover over the Totals cell under % Complete in the Total row 
d. Select “Average” 

7. After adding some tasks, click “Show in Standard View” to close the 
Datasheet 

 Synchronize the Tasks list with Excel  

1. Click “Export to spreadsheet” under “Actions” in the left navigation zone 
2. Choose “Open” twice when prompted 
3. Make changes to the data when you are in Excel 
4. If the List toolbar is not visible turn it on: View  Toolbars  List 
5. Click the third icon from the left: “Synchronize List” 

 
6. Exit Excel.  Click “No” when asked to save. 
7. Browse back to the tasks list and click the Refresh button in Internet 

Explorer.  The changes you made in Excel should appear 
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 Create a picture library  

1. Click “Create” in the top navigation bar 
2. Click “Picture Library” from the Picture Libraries section 
3. Type “Research Pictures” in the Name files 
4. Click “Create” at the bottom of the page 
5. Click “Add Picture” in the toolbar 
6. Choose “Upload Multiple Files…” 
7. Microsoft® Office Picture Manager will open.  From the folder view on the 

left side of the page expand “My Pictures” 
8. Click “Research” 
9. Click on one of the images and “Ctrl-A” to select all of the images 
10. Click “Upload and Close” to upload the images 
11. Return to the browser and click “Go back to “Research Pictures”” 

 Browse to the Events list and add a recurring weekly team meeting  

1. Click “Documents and Lists” in the top navigation bar  
2. Click “Events” from the Lists section  
3. Click “New Item” in the toolbar 
4. Enter “Team Meeting” in the Title field 
5. Select a Begin time during business hours 
6. Choose “Weekly” under recurrence and select “Monday” 
7. Select “End after:  occurrence(s)” and enter “5” 
8. Click “Save and Close” in the toolbar to save the event 

 Look at the events list in monthly, daily, and weekly views  

1. Click “Calendar” in the left navigation zone 
2. Click “View by day” and “View by week” in the toolbar to navigate 

between the views 

 Link to the Calendar and show events side-by-side with calendar in 
Outlook  

1. Click “Link to Outlook” in the toolbar 
2. Click “Yes” when prompted (you might need to switch focus to Outlook) 
3. View your calendar in Outlook 
4. Select “Calendar” under the “My Calendars” section on the left side of the 

Outlook to view your personal calendar and the SharePoint calendar side-
by-side 

5. Drag-and-drop the appointment from the SharePoint calendar to your 
personal calendar 

 Create a Meeting Workspace from Outlook  

1. Add an appointment to your personal calendar using the “New” button in 
the Outlook toolbar 

2. Enter any data you choose for Subject, etc. 
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 3. Setup recurrence to end after 5 occurrences 
4. Enter Leah Clelland as an Attendee in the Scheduling tab 
5. Switch back to the Appointment tab and click “Meeting Workspace” 
6. In the Workspace task pane on the right side click “Change Settings” under 

the “Create a workspace” section  
7. Select “Other…” from the “Select a location” drop-down list 
8. Type “http://server/sites/research/” in the Meeting Workspace address field, 

click “OK” 
9. Click “OK” and “Create” at the bottom of the Meeting Workspace task pane 
10. Click “Go to Workspace” in the Meeting Workspace task pane 
11. Navigate around the workspace  
12. Close the workspace browser 
13. Close the appointment in Outlook.  Click “No” when prompted to save and 

“No” again when prompted to send 

 Customize the home page  

1. Switch back to the Jeff Teper browser, click “Home” in the top navigation 
bar 

2. Click “Modify Shared Page” and then choose “Add Web Parts  Browse” 
3. Click “Next” at the bottom of the web parts list 
4. Drag the “Research” web part library onto the homepage 
5. You can drag other web parts from the Web Parts Tool Pane if you desire 
6. Close the Web Parts Tool Pane 

 Subscribe to a document  

1. Click “Home” in the top navigation bar (if you are not already there) 
2. Click “Research” in the left navigation zone 
3. Choose “Alert me” from the “Actions” section” in the left navigation zone  
4. Select “Deleted items” from “Alert me about:” 
5. Select “Send e-mail immediately” 
6. Click “OK” at the bottom of the page 

 Verify the Alert  

1. Wait for the e-mail notification that you have signed up for the alert.  
(Outlook is currently polling every minute.) 

2. Hover-over one of the documents you created an alert for and click the 
down arrow to the right 

3. Choose “Delete” from the menu and click “OK” at the prompt 
4. Wait for the e-mail notification that the document has been deleted 

 Save the site as a template 

1. Click “Site Settings” in the top navigation bar 
2. Click “Go to Site Administration” under the “Administration” section 
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3. Click “Save site as template” under the “Managements and Statistics” 

section 
4. Enter in “Research Projects Template” for the File name and Title fields 
5. Click “OK” at the bottom of the page 
6. Click “OK” to return to Top-level Site Administration 
7. Click “Create” in the top navigation bar 
8. Click “Sites and Workspaces” under “Web Pages” section 
9. Type Projects for the Title and URL name fields 
10. Click “Create” at the bottom of the page 
11. Choose the “Research Projects Template” and click OK to create a new web 
12. Notice the “Research” and “Research Pictures” in the left navigation zone 
 
You have successfully completed this module. 
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Module 2 

Exercise 1  
Navigate the Contoso Site 

In this exercise, you will navigate through a Windows SharePoint Services site 
built using FrontPage.   

 To open the Windows SharePoint Services site in FrontPage 

1. On the Start menu, point to All Programs | Microsoft Office and click 
Microsoft Office FrontPage 2003. 

2. From the File menu, select Open Site… 
3. In the Open Site dialog box, type http://server/sites/vitaminrnd for the Site 

Name and click Open. 

 To view the site in a browser  

1. Select the “home.aspx” page in the site tree. 
2. Press F12 to preview the page in the browser. 

Note this page has the common characteristics of a Windows SharePoint 
Services team site:  
a. Top navigation and side bar 
b. Announcements, Links, and Events lists 
Note that this page also has a section with a list of recent clinical trial results 
that the research team has conducted. 

3. Click on the first item in the “Clinical Trial Results” 
When you click on one of these items, it brings you to a detail page for that 
clinical trial.  The interesting thing about this page is that while it looks like 
a nicely laid out HTML page, it is actually a page with a XSLT data view on 
live XML data.  In this case, the XML data is coming from a file that was 
created using Microsoft® Office InfoPath™ 2003.  You can see this is rich 
data including text descriptions about the trial, picture and detail info about 
the researcher, and detail tabular data about the trial results. 

4. Click on Back in Internet Explorer. 
5. Choose the 3rd item in the “Clinical Trial Results” 

And if we return to the home page and choose another clinical trial, we'll see 
the same rich formatting but with different text, researcher, and results.  
So you can see, we've extended this Windows SharePoint Services site by 
sharing the XML data created in InfoPath forms. 

6. Close the browser. 
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Exercise 2  
Build the Home Page 

In this exercise, you will start to build the home page functionality you saw in 
the previous exercise.   

 To open the home page for customization 

1. Look in the folder pane to find “home_custom.aspx” at the root. 
2. Double-click this file to open it in the designer 

Here we have the home page that we saw in the previous exercise. The page 
is nicely laid out using HTML tables and it contains web parts for the list of 
announcements, links and events. You can see the areas containing the lists 
has been customized using the FrontPage cell formatting features to set a 
nice background color and professional looking drop shadow. 
At the bottom of the page is where we want to add the list of clinical trial 
results. 

3. Look in the folder pane, find and expand the “Clinical Trial Results” 
document library. 

4. Right-click on “Senior.xml” and choose Open With… | Microsoft Office 
InfoPath. 
In InfoPath, we can make edits to the xml through a nice forms interface 
that adheres to and enforces the customer defined schema. 
NOTE: You may need to set focus to InfoPath. 

5. Close InfoPath without saving any changes. 
6. To view the XML file directly in the FrontPage editor, right-click on 

“Senior.xml” and choose Open With… | FrontPage (Open as XML). 
7. Close the xml document. 

 Add the list of Clinical Trial Results documents 

1. Click to place insertion point in the section of the page under “Clinical Trial 
Results” 

2. From the Data menu, select Insert Data View 
Note the various data sources available in this web site: SharePoint lists and 
document libraries, databases, XML files and XML Web Services. 

3. Expand the “SharePoint Libraries” section 
4. Hover over “Clinical Trial Results” 
5. Click the drop-down arrow and select Show Data 
6. Select the “Name (for use in forms)” item in the tree 
7. Click the link for Insert Data View 

Note that this is not a snap shot; it is a live view on the contents of the 
document library and it will stay up to date as new files are added. 

 Preview the page in the Browser 

1. Press F12 to preview the page in the browser.   
2. Select “Yes” when prompted to save. 
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 3. Close the browser. 
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Exercise 3  
Create the Trial Results Detail page 

In this exercise, you will start to build the Trial Results Detail page 
functionality you saw in exercise 1.   

 Create the Trial Results Detail page 

 First we’ll apply the site template to a new page to apply our common look. 
We are going to use a new FrontPage feature called Dynamic Web 
Templates (DWT). A DWT is a great way for web designers to author and 
control a common look to the pages in a web site. By defining a DWT and 
applying it to pages in the web site, the web designer can lock down parts of 
pages and specify which parts of the page can be edited with custom 
content. Any updates made to the DWT can be automatically applied to the 
pages using the template. 

1. Look in the folder pane, expand “contoso_images” and find the 
“contoso_template.dwt” file. 

2. Right-click contoso_template.dwt and select “New from Dynamic Web 
Template” from the menu. 

3. Click Close to dismiss the dialog. 

 Create the details view 

We'll use the Data menu to go back to the data source catalog, and this time 
instead of the document library, we'll choose one of the trial results xml 
files. 

1. Click to place insertion point in the body section of the page 
2. From the Data menu, select Insert Data View… 
3. Click to expand the XML files 
4. Hover over “Adult.xml”, click the drop-down arrow, and choose the 

command Show data. 
This switches to the data details task pane.  You should see the “Project” 
node of the tree expanded. 

5. Select the “Name” attribute in the tree (the 1st node under “Project”), and 
click on Insert Data View 

 This inserts a data view with a single item for the Project Name. 
6. Click to the right of the word “Adult” in the data view (center pane) and 

press the down arrow key.  This will move the curser down a line. 
7. Type the text "Summary:" and press Enter.  
8. Click on the summary item in the tree, drag the item into the view, and 

drop in the empty line below "Summary:". 
9. Click on the “summary” text you just inserted and press the “I” button on 

the toolbar to make it italic. Press the color drop down “A” button on the 
toolbar and click on the “Hex={00,33,99}” button under “Document 
Colors” to make it blue.  

10. Click to the end of the summary text and press Enter. 

 Create the Researchers table 
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We can use the new FrontPage table layout tools to allow precise placement 
of content in the data view using standard HTML tables to control the 
layout. We'll make a couple of table cells to hold the information for the 
researcher and researcher’s picture. 

 

1. From the Table menu, select Layout Tables and Cells…, the Layout 
Tables and Cells task pane will appear. 

2. Click the Draw Layout Table icon  and drag out a layout table from the 
current cursor location to about half the width of the page and 5 or 6 lines 
deep.  When you draw the table, you will actually drag it outside the data 
view, that's OK, the data view resizes to contain the table. 

3. Click the Draw Layout Cell icon  and draw a cell in the left side of the 
table taking up almost half the tablewidth.  

4. Click the Draw Layout Cell icon  and draw a cell in the right side of 
the table taking up the rest of the table width.  
Draw 2 cells, side by side - you'll have to experiment to get the sizes what 
you want for the content. 

5. Click in the 2nd cell.  

 Populate the Researchers table with data 

We’ll add information about the researcher conducting this trial; the 
doctor’s name, job title and email address.  Since we are working with 
XSLT and HTML, we can format her email address to be a mail-to link. 

1. From the Data menu, select Insert Data View… 
2. Click to expand the XML files 
3. Hover over “Adult.xml”, click the drop-down arrow, and choose the 

command Show data. 
This switches to the data details task pane.  You should see the “Researcher” 
node of the tree expanded. 

4. Click on the “Name” item below “Researcher”, drag the item into the view, 
and drop in the 2nd layout cell you created.  

5. Click the End key, then Shift-Enter to create a new line  
6. Click on the “jobTitle” item in the tree, drag the item into the view, and 

drop in the new line from (5).  
7. Click the End key, then Shift-Enter to create a new line.  
8. Click on the “emailAddressPrimary” item in the tree, drag the item into the 

view, and drop in the new line from (7).  
9. Right-click on the text “janet@contoso.com”, and choose the sub menu: 

Format Item As… | Hyperlink 

 Populate the Researchers table with pictures 

We'll add the picture of the researcher. In this case instead of dragging the 
link to the picture into the view, we'll choose to insert the data item as a 
picture. 

1. Click in the first layout cell  
2. Right-click on the “picture” item below the “Researcher” section.  
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3. Choose Insert as picture  
4. Ctrl+S to save the page, type the name "Trial_Custom.aspx" and Save. 

NOTE: It is OK if the image does not display correctly in this step.   

 Add a View on repeating, hierarchical data 

1. Click to the right of the layout table and press Enter to open some space 
2. Click in the empty line you just created, type "Results:", and press Enter.  
3. In the data tree, click the plus icon next to the “Trial_Results” item in the 

tree to expand the trial results node.  
4. Click the plus icon to expand “Group” and then the plus icon to expand 

“SubGroup”.  
5. Click on the little arrows next to the record set indicator to the right of the 

“Trial_Results [1/3]”. Note that these are repeating elements  
6. Click on the “Name” item under “Group”.  Hold the Control key down and 

click on the “Name”, “Remission”, and “Symptoms” items under 
“SubGroup”.  

7. Click on Insert subview to insert the data items into the page.  FrontPage 
detects the shape of the repeating data and creates the appropriate XSLT for 
displaying this data formatted in HTML tables.  

 Format the data with XSLT 

1. Right-click on the "Symptoms" value in the first row, and choose the sub 
menu: Format Item As… | Number.  

2. In the Format Number dialog, click on the radio button for "Percentage" and 
use the arrow buttons in the "Decimal places" control to show 2 decimals. 
Press OK.  

3. Click on the drop-down arrow of the tag toolbar on the high-lighted "<xsl-
value-of>" item. Choose the menu item for Edit Tag.  

4. Click on the red X to dismiss the tag editor. 

 View the XSLT in the code editor 

1. Click the “Split” button at the bottom of the page.  
2. Click in the code portion of the window, and press Ctrl-F. Type "format-

number" and press Enter.  
3. Click the Close button  
4. Point to the "format-number" function in the code.  
5. Click the “Design” button at the bottom of the page.  

 Add final data elements to the page 

1. Click in the empty line at the bottom of the view and type, "Notes:".  
2. Press Enter twice.  
3. In the data tree, click the plus icon next to the “EndNotes” item in the tree to 

expand the end notes node.  
4. Drag and drop the “Conclusions” item onto the first empty line created in 

(1).  
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 5. In the data tree, click the plus icon next to the "Sites" item in the tree to 
expand the trial sites node.  

6. Double click the "SiteInfo" item to select and expand it.  
7. Click the Insert subview link to insert a view on the site info. 

 Change the style from tabular to comma separated 

1. Click in the “SiteInfo” table you just created. 
2. Click the Style link in the task pane to bring up the style dialog.  
3. Select the 6th style in the list (Comma separated)  
4. Press OK to apply the style.  
5. Click “Yes” to apply formatting. 

 Preview the page in the Browser 

1. Press F12 to preview the page in the browser.   
2. Select “Yes” when prompted to save. 
3. Close the browser. 
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Exercise 4  
Connect Home page to Trial Results Detail page 

In this exercise, you will hook the list of trial results on the Home page up with 
the Detail Page you created in the previous exercise.  This is how we are able to 
reuse the XSLT we just authored to apply to every xml document saved to the 
document library. 

 Hook the Home page to the Trial Results Details page 

1. Switch to the “home_custom.aspx” page in the FrontPage Designer.  
2. Click in the clinical trial results data view.  
3. From the Data menu, select Web Part Connections.  
4. Press Next to move to 2nd step of the wizard  
5. Select radio button for "Connect to web part on another page in this web", 

and type "trial_custom.aspx"  
6. Press Next to move to 3rd page in wizard.  
7. Leave setting unchanged for Target Web Part,  
8. Change the drop-down for Target action to "Modify View Using Parameters 

From"  
9. Press Next to move to 4th page in wizard.  
10. Change the “Columns in Clinical Trial Results” for “InputFile” to the value 

"Title" by clicking on in-list drop-down control.  
11. Press Next to move to 5th page in wizard  
12. Select “Name (for use in forms)” from the hyperlink drop-down. 
13. Press Next to move to final page of wizard.  
14. Press Finish 

 Preview the page in the Browser 

1. Press F12 to preview the page in the browser.   
2. Select “Yes” when prompted to save. 
3. Click “OK” to save both pages (if prompted). 
4. Close the browser  
 
You have successfully completed this lab! 
 

 


	LAB PRT03: Integrating Microsoft® SharePoint® Products and Technologies with Microsoft® Office Professional Edition 2003 Applications 
	Objectives 
	Estimated time to complete this lab: 120 minutes 

	Module 1 
	Exercise 1  Exploring Windows SharePoint Services Features 

	 Module 2 
	Exercise 1  Navigate the Contoso Site 
	Exercise 2  Build the Home Page 
	Exercise 3  Create the Trial Results Detail page 
	Exercise 4  Connect Home page to Trial Results Detail page 



